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Resolution
All digital images are made up of pixels, which are squares that divide the image up into small pieces. 

Pixels can be counted, and the more of them you have, the more detail you can reproduce. To determine 

resolution, you need to combine the pixel count with size per inch. The higher the pixel count per inch the 

better detail or resolution.
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What resolution should you choose? The answer is 300 to 450.  You can often tell just by how the image 

looks on a computer screen or how it prints out on any printer if the quality is up to par, if an image is blurry 

or pixilated on a computer screen, its not going to look any better once it goes to the printer.

PPI (pixels per inch) is used when we are talking about the image on the computer, dpi (dots per inch) is 

used when we are talking about the image on paper.

Digital Camera Images
Digital cameras measure how many millions of pixels they capture (mega pixels) not the resolution. When 

you open a digital camera picture in Photoshop it has to apply a specific resolution most likely will be 72 

resolution which makes the physical size very large. For example a 3 mega pixel picture at 72 dpi will be 

approximately 28 x 21 so even though 72 resolution seems really low pay attention to the physical size of 

the picture which may cause some problems for you when creating your document. You can trade size for 

resolution and scale the picture down in Photoshop.

5 PPI (pixels per inch) 10 PPI (pixels per inch)

High Resolution
300 dpi

Low Resolution
75 dpi
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Changing the resolution (In Photoshop®)
Low to High: You can print a low resolution image however it won’t look as good as a higher 

resolution image. If you have a low resolution file and you want a high resolution file you can 

change the resolution from 72 dpi to a 300 dpi however this doesn’t add detail that isn’t already 

there. You can’t put a scrabbled egg back together. If you only have a low resolution file the 

only thing you can do to make it look better is apply a few Photoshop tricks like adding some  

filters such as blur, sharpen or consider printing your image a smaller size to gain effective resolution.

High to Low: More than 450dpi can be used, however the human eye will not pick up any extra detail and will 

make your document much to large for transferring and printing.  In Photoshop you can try the following:

Select Image Size:
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Notice the Width and Height will change when you change your resolution however the quality will remain 

the same as long as you do not use Resample Image.

Change your resolution to 
desired size.

Do Not Use
Resample Image



Color
RGB (red, green, blue): Computer monitors emit color as RGB (red, green, blue) light. Although all colors 

of the visible spectrum can be produced by merging red, green and blue light, monitors are capable of 

displaying only a limited gamut (I.e., range) of the visible spectrum. The same art displayed on a computer 

monitor may not match to that printed in a publication. Your service bureau will not print your piece in RGB.

CMYK (Four Color Process): Cyan, Magenta, Yellow, Black. During separation, screen tints comprised of 

small dots are applied at different angles to each of the four colors. The screened separations are then 

transferred to four different printing plates, one for each color, and run on a printing press with one color 

overprinting the next. The composite image fools the naked eye with the illusion of continuous tone.
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Starting Photo The photo is broken down into the four colors.          
The printer will have four corresponding printing 

plates to use with the four inks (CMYK).  Layering and 
combining ink together on paper to recreate the image.

Or your file will be printed on a digital color press 
which is basically the same process except there 
are no printing plates produced and a copier is 

toner-based and not ink-based.

Ending Photo



PMS (Spot Color): Pantone® Matching System. Colors created without screens or dots are referred to in the 

industry as spot or solid colors. Each of the spot colors in the PANTONE® MATCHING System is mixed 

according to its own unique ink mixing formula developed by PANTONE®.

You may have noticed when selecting a PMS color in your program a letter follows the number. This 

represents the type of paper your piece will be printed on. For example PMS 123U the U stands for 

Uncoated paper, PMS 123C the C stands for Coated paper, PMS 123M the M stands for Matte. Pantone 

added these because the final result of the color will look different depending on which paper is chosen to 

print on.  Whichever style you choose you have to make sure that you remain consistent throughout your 

document. This is especially important if you are creating graphics in other programs such as Illustrator 

then bringing those into your InDesign document. The color extensions have to remain the same, if not the 

computer sees it as two different colors. even though they have the same number. 

Do not rename your swatches to anything other than the PMS color it may cause error or confusion in 

which PMS color to use. Do not convert your PMS color to CMYK or RGB in order to adjust your color, 

simply pick a new PMS color.

Do not create a new swatch just for a percentage of the original. You can make an object a percentage of 

the original PMS color by selecting your object, fill it with your PMS color then adjust the Tint slider to the 

desired percentage.
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Adjust the Tint slider 
(InDesign®) instead of 
creating a new swatch

Even though these are both PMS 123 the computer seems them 
as separate PMS colors because one is 123 U and one is 123 M. 

One must be deleted in order to get one PMS color output.

Adobe Illustrator®

Tint Slider.



How to create a SPOT color swatch:
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Swatches >     > New Color Swatch

A.  Color Type > Spot

B.  Color Mode > PANTONE Solid Coated

Adobe InDesign®

Adobe InDesign®

Windows > Swatch Libraries > Color Books

Double-Click on the swatch 
you want and it will be added 
to your swatch list.

Your document should only be in ONE format, all CMYK or all SPOT, but not combined.
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Bleeds
Bleed: A page element that extends past the trimmed edge of the finished page.

The image can not run right up to the edge of the paper otherwise the ink would bleed onto the back side 

of the paper if this was running on a printing press. If it were running on a digital color press, the printer 

margins would cut off the image instead of letting image run right to edge. So the job must be run on a 

larger sheet of paper and cut down to the desired size.

When using “bleeds” you must allow for the art to extend no less than 3/16in. up to 1/4in. beyond the page border. 

The paper size that it will print on will increase. 

Crop (Trim) Marks - Finished size 
of your document.

This portion, typically 1/8 inch 
is trimmed/cut off all the way 
around the image.

Paper - The paper your project 
is running on must be larger 
than the finished size of your 
piece.

Do not try to create bleeds by increasing your page size. For example if you want to create a 8.5x11 piece 

with bleeds. Create your page as 8.5x11 and design your bleeds past final trim.
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Margins
Margins: Space separating text or other elements from the edge of the paper.  The standard margin settings 

are no less than 3/16” up to 1/4” on all four sides.

No Text in this 1/4in space.

1/4in space1/
4i

n 
sp

ac
e

1/4in space

Nothing in this 1/4in space.

1/4in space

1/
4i

n 
sp

ac
e

1/4in space

Pictures and text 
inside this area.

Sample of page without bleeds 
running on exact size paper.

Sample of page with bleeds 
running on oversize paper.

Other Margins to Consider: 

3 Hole Drill Spiral Binding Hot Tape Binding
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Pagination
A pagination is the page order a printer needs a document set up according to how the document is going 

to bind. If your not sure how to paginate your project talk to your pre-press service provider. Most likely 
they will not ask you to paginate your job because most of the new RIP’s (raster image processor, the computer 

software used to create printing plates) will paginate for you. At Mountain Media we ask that your document be 
sent to us 1 up in consecutive order and we will paginate for you.

It is a good idea to know how to paginate a job so you do not have any design issues. Below is a basic 

overview to familiarize yourself.

Printer Spreads: Printer spread refers to two or more pages that fall next to each other on a sheet of paper. 

(The order in which the project is printed.)

Reader Spreads: The order in which you read the project.

Saddle Stitch: This is a typical magazine bind in printer spreads, two pages are printed on the same sheet, 

folded, and collated, the pages end up in the appropriate order. The process of creating printer spreads 

from layout spreads is called imposition. (2up different)

1 2 3

  

18 72 36 54

18 36

4527

Divisible By FOUR: If the number of pages to be imposed is not evenly divisible by 4, blank pages are added 

to the back of the finished document.

Final Printed Piece Final Printed Piece
Fold Together for Binding

Sheet 1 - Front Sheet 2 - Back Sheet 3 - Front Sheet 4 - Back
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Cut Stacks: The printed sheets are cut in half. Then the left half is placed on top. No folding.

  

51 26 73 48

51 73

8462

Continuous: The pages will simply run 1,2,3,4,... this won’t be folded in half, just stapled along an edge or in 

the corner. This is a good way to present a hand-out.

Final Printed Piece Final Printed Piece

Sheet 1 - Front Sheet 2 - Back Sheet 3 - Front Sheet 4 - Back

51

62

51

62

Cut

Take left side and stack on top of the right.



Adobe® Illustrator® CS3 
File > Save As > Choose a Location to Save PDF **Make sure you change Save as type: to Adobe PDF.**

You will then get the same distiller box as shown above and again you will want to choose Press Quality.
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PDF’s (Portable Document Format)
Adobe®Acrobat® and Adobe® Reader®are separate applications, Adobe® Reader® is free, universal software 

that lets you open, view, search, and print PDF files.You cannot create a PDF file using Adobe® Reader®, to 

create Adobe PDF documents, you must have the program Adobe® Acrobat® (Standard or Professional).

People are under the impression “if I make a PDF file it will print correctly.” However a PDF needs to be written 

correctly. Fonts for example need to be embedded and the PDF needs be written with a press setting for high 

resolution. There are problems that can happen when printing from a PDF that will not show up on a computer 

screen, such as the transparencies issues. A PDF is only as good as the file it came from. In other words, if I 

used a low resolution picture in my document and then created a PDF at the high resolution settings, it is not 

going to change the resolution of the original source and it will still be a low resolution picture.

How to create a PDF:

Adobe® InDesign® CS3

File > Export > Select a location to save your PDF > The new window that displays is actually your distiller setting. 

You want to choose Press Quality to get highest resolution possible or we also offer a iGen distiller setting.

This is also the time to make sure your 
PDF gets the bleeds you’ve added along 
with crop marks. It’s only necessary to 
add Crop Marks.



Microsoft Publisher 2003 
Adobe PDF > Change Conversion Settings > Select Press Quality > Convert to Adobe PDF

Microsoft Word 2003
File Print > Select Adobe PDF > Properties > Under Adobe PDF Settings tab change default setting to Press 

Quality > OK

Microsoft Publisher and Word 2007 

File > Print > Printer Name = Adobe PDF > Properties > Default Setting = High Quality Print > OK

11
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Transparency’s
What is a transparency? An object is a source of transparency if any of the following applies:

• It has an opacity of less than 100%.

• It has an opacity mask.

• It has a inner glow or outer glow effect.

• It has any blending mode other than Normal.

• It has a drop shadow or feather.

• It’s fill or stroke has a style, brush, pattern, or filter effect that has any of the previous properties.

• It is a placed Photoshop file (native, PDF, or TIFF) with a transparent background.

• It is a placed Illustrator file (native or PDF) that contains one or more objects with any of the
 previous properties.

Fixing Transparency Issues:

If you are trying to get a lighter version of your color don’t add a transparency by adjusting the Opacity to less 

than 100%, use the tint slider instead.

Common transparency issues may 

print like the sample below;

but look perfectly normal

on your computer screen.

Leave Opacity
at 100%

Adjust the Tint 
slider instead.



Open and flatten your file in Photoshop®. You can open your entire design or just the portion that contains the 

transparency. The easiest way I have found to achieve this is to first write a PDF, select that PDF, and open in Photoshop®.

From Photoshop®: File Open > select your PDF >

Resolution should 
be 300 and mode 
should be CMYK

Save file as a .tiff and bring that .tiff into your page layout program. 

This solution will not work for every job and it is certainly not the only 

solution. Every job is unique and what works for one may not work for 

the next. This method would not work if you were printing your piece 

in a PMS color, however some transparency issues do not appear 

when printing color separations as you see them in composites. 

You can also try using InDesign® you can use the feature Simulate Overprint: 

File > Print > Printer = Adobe PDF > Simulate Overprint > Setup > Preferences > Default Settings = High Quality Print

Layers >      > Flatten Image

Window Format
Note: Choosing to print with Simulate Overprint on will 
convert your PDF to CMYK so if you are printing your piece 
in spot color this method would not work.

13
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Bitmap and Vector Images
Bitmap images: (Adobe® Photoshop®)

 
Bitmap images—technically called raster images—are made up of a grid of dots known as pixels. When working 

with bitmap images, you edit pixels rather than objects or shapes. Bitmap images are the most common electronic 

medium for continuous-tone images, such as photographs or digital paintings, because they can represent 

subtle gradations of shades and color. Bitmap images can lose detail when scaled on-screen because they 

are resolution-dependent. They contain a fixed number of pixels, and each pixel is assigned a specific location 

and color value. Bitmapped images can look jagged if they’re printed at too low of a resolution because the 

size of each pixel is increased.

Example of a bitmap image at different levels of magnification

Vector graphics: (Adobe® Illustrator®, Adobe® InDesign®) 

Vector graphics are made up of mathematically defined lines and curves called vectors. You can move, resize, or 

change the color of a line without losing the quality of the graphic. Vector graphics are resolution-independent—

that is, they can be scaled to any size and printed at any resolution without losing detail or clarity. As a result, 

vector graphics are the best choice for representing bold graphics that must retain crisp lines when scaled to 

various sizes (logos, for example).

Example of a vector graphic at different levels of magnifi cation 

Note: Because computer monitors can display images only on a grid, both vector graphics and bitmap images 

are displayed as pixels on-screen.

 

Type in Photoshop may 
look pixilated because 
it’s made out of pixels.

Type as actual type or 
vector graphic will be 
much cleaner.
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Fonts
A font is a complete set of characters—letters, numbers, and symbols—that share a common weight, width, 

and style, such as 10-pt Adobe Garamond Bold.

Typefaces (often called type families or font families) are collections of fonts that share an overall appearance, 

and are designed to be used together, such as Adobe Garamond.

A type style is a variant version of an individual font in a font family. Typically, the Roman or Plain (the actual 

name varies from family to family) member of a font family is the base font, which may include type styles 

such as regular, bold, semi bold, italic, and bold italic.

It is a good idea to keep the amount of fonts you use in a single project to a minimum. You can use one or 

two specific fonts then use the various styles of the same font to give your document more interest instead of 

switching to a different font. I have seen designers use 15 or more different kinds of fonts in one document and 

it really opens the door to more font issues and makes the piece look confusing. So it is a good idea to keep 

this in mind while designing.

Types of Fonts 
PostScript or Type1 (.pfb, .pfm) 

PostScript was originally developed by Adobe and was engineered with two parts to each font – a screen 

font for rendering characters on a computer monitor and a printer font to direct a PostScript printer how to 

render the font on paper. These are not interchangeable between Macintosh and Windows based computers.

Mac OSX 

The new operating system for Macintosh has changed their font structure dramatically. You can use the same 

fonts that you used with Mac OS 9 however the fonts are going to look different. For example, suitcases don’t 

look or even seemingly behave like suitcases in Mac OS X.  A font suitcase file in Mac OS X typically appears 

exactly as a single font file does– but they still work the same way.

Example of what a Windows Postscript font will 
look like. One is a screen font and one is a printer 
font. You need to send both in order for the font to 
work correctly.

Example of what a Mac OS 9 
and earlier Postscript font will 
look like. The screen fonts are 
on the suitcase (top) and there 
is a separate printer font for 
each type style. (Bold, Italic) 
You need to send both in order 
for the font to work correctly.

= Font Suitcase = Printer Font
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True Type (.ttf) 

The TrueType format was introduced around 1991 by Apple Computer. You only need one file in order to use 

these fonts but a separate file for each type style. Not interchangeable between Macintosh and Windows.

(Bold) (Bold Italic)

Example of what a True Type font 
will look like in windows.

Example of what a True Type 
Mac font will look like in OS9   

or earlier.

Example of what a True Type 
font will look like in Mac 

OSX.

Open Type (.otf) 

The OpenType format was developed by Microsoft Corporation and Adobe Systems in the late 1990s, and 

later supported by Apple Computer. The intent was to eventually replace Type 1 and TrueType by offering 

platform-independent font files so interchangeable between Macintosh and Windows. You only need one file 

in order to use these fonts but a separate file for each type style.

Example of what an Open Type 
font will look like in windows.

Example of what an Open Type 
Mac font will look like in OS9   

or earlier.

Example of what an Open 
Type font will look like in Mac 

OSX.

Locating, installing and collecting your fonts
Windows   C:\WINDOWS\Fonts also C:\PSFONTS

1. Open My computer
2. Double click on C drive
3.  Double click on Windows Folder
4. Double Click on Fonts folder
5. Highlight fonts you want to copy
6. Select Edit > Copy
7. Go to desktop and right click select New folder
8. Open that folder and select Edit Paste
9. Close that folder, highlight folder > Right click > select Send to compressed zipped folder
10. Send the new .zip folder 

If you are sending a Type1 font make sure to include both parts of the font; printer and screen.

InDesign® will collect your fonts for you when you package a file: You can gather the files you’ve used, 

including fonts and linked graphics, for easy handoff to a service provider. When you package a file, you 

create a folder that contains the InDesign document, any necessary fonts, linked graphics, text files, and a 

customized report.
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Mac OSX
~/Library/Fonts/ [The tilde character (~) represents a user’s Home, which may be local or remote.]

Each user has complete control over the fonts installed in their Home. These fonts are available to that user 

when logged in to the computer. Fonts installed here are not available to all users of the computer. 

/Library/Fonts/

Any local user of the computer can use fonts installed in this folder. Mac OS X does not require these 

additional fonts for system operation. An Admin user can modify the contents of this folder. This is the 

recommended location for fonts that are shared among applications.

/Network/Library/Fonts/

The Network folder is for fonts shared among all users of a local area network. This feature is normally used 

on network file servers, under the control of a network administrator.

/System/Library/Fonts/

Mac OS X requires fonts in this folder for system use and displays. They should not be altered or removed.

/System Folder/Fonts/ [Do not confuse the Mac OS 9.1 “System Folder” with the Mac OS X “System” folder.]

This folder contains fonts used by the Classic (OS 9) environment.
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Compressed Files
Compressed files take up less storage space and can be transferred to other computers more quickly than 

un-compressed files. You can also combine several files into a single compressed folder, making it easier 

to share a group of files, since you only need to attach one folder to an e-mail message instead of several 

files, you’ll ensure that the integrity of your data is intact and readable to the recipient.  It also protects file 

attribute information for both PC and Mac files. Windows and Mac OS X format have the .zip program already 

available.

How to .zip (Windows)

How to .zip (Mac OSX)

1. Select the folder you want to .zip
2. Right Click
3.  Choose Send To
4. Choose Compressed (zipped) Folder

There will now be a new folder in same 
location as 

your original folder with the .zip extension.

Extension = the last set of letters 
following your document/file name. 
Each program has it own unique extension.

1.  Select the folder you want to .zip
2. Hold down Control key and click
3.  Choose Create Archive of “project”

There will now be a new folder in same 
location as your original folder with the .zip 
extension.



Helpful Info
Business Card = 3.5 x 2

Envelopes
 #10  =  4.125 x9.5
 #9  =  3.875 x 8.875
 A2  =  4.375 x 5.75
 A6 = 4.75 x 6.5
 A7 = 5.25 x 7.25
 A8 = 5.5 x 8.125
 A10 = 6 x 9.5
 Slimline =  3.875 x 8.875

 Single Card
 4.25 x 5.5
 4.625 x 6
 5.125 x 7
 5.375 x 7
 5.875 x 9
 3.75 x 8.6

 Narrowfold Card
4.25 x 1155
4.5 x 12.5.256
5 x 14 7
5.25 x 15.5.8757
5.75 x 18.5.259
3.75 x 17.256256

 Broadfold Card
 5.5 x 8.5

 6.25 x 9
 7 x 10
 7.75 x 10.55
 9.25 x 11.55
 7.5 x 8.62525

 Frenchfold Sheet 

 8.5 x 11
 9 x12.5
 10 x 14
 10.5 x 15.5
 11.5 x 18.5
 7.5 x 17.25

Letter                                         Legal                                        Tabloid

Narrowfold Broadfold

Half Folds

Double Right-Angle Fold

Crossfold: Two (or more) folds which are perpendicular, folded
half, then in half again at a right angle to the  rst foldin 

Parallel Fold: Two or more folds running in the same direction

Accordianfold Cfold - TrifoldDouble Gatefold Double Parallel

Barrel Fold: Consists of two or more parallel folds. Barrel Fold is also known as Letter Fold, Roll Fold, Spiral Fold, or
Tri-Fold

11 14

178.5 8.5

11
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Decimal Conversion
 1/32  .03125
 1/16  .0625
 3/32  .09375
 1/8  .125
 5/32  .15625
 3/16  .1875
 7/32  .21875
 1/4  .25
 9/32  .28125
 5/16  .3125
 11/32 .34375
 3/8  .375
 13/32 .40625
 7/16  .4375
 15/32 .46875
 1/2  .5

17/32 .53125
9/16  .5625
19/32 .59375
5/8  .625
21/32 .65625
11/16 .6875
23/32 .71875
3/4  .75
25/32 .78125
13/16 .8125
27/32 .84375
7/8  .875
29/32 .90625
15/16 .9375
31/32 .96875
1  1

GLUE AREA ANYTHING PRINTED IN THIS AREA MA AYAA  BE DESTY ROYEDOO WHEN OPENED.

GLUE OVERLAP ANYTHING PRINTED IN THIS AREA MAY BE DESTROYED WHEN OPENED.

GLUE AREA ANYTHING PRINTED IN THIS AREA MAA Y AA BE DESTROYEDOO WHEN OPENED.

GLUE OVERLAP ANYTHING PRINTED IN THIS AREA MAY BE DESTROYED WHEN OPENED.

GLUE AREA ANYTHING PRINTED IN THIS AREA MAA YAA BE DESTROYEDOO WHEN OPENED.

DOTTED
LINE
REPRESENTS
PERFORATION

3.3125

3.5 6.25

4

3.5 6.5

.75 {

C fold - Trifold - Letter Fold

3.6875in 3.625in3.6875in 3.6875in3.625in 3.6875in

Front Inside

1 Way Remittence 2 Way Remittence

Points� Pixels� Inches
12 .125

18 24 .25
36 48 .5
72 96 1
108 144 1.5
144 192 2



Absorption: In paper, the property which causes paper to take up 
liquids or vapors in contact with it. 

Accordion Fold: In binding, a term used for two or more parallel 
folds which open like an accordion.

Bindery: The final step of a printing process which includes 
cutting, trimming, drilling, collating, folding and stapling.

Bitmap: A computerized image made up of dots or pixels, when 
resolution is low, bitmapped images give a jagged appearance 
on paper or film.

Bleed: Printing which extends beyond the edges of a final 
trimmed piece of paper. 

Blind Embossing: A finishing process in which a design is formed 
into a sheet using a die causing a slightly raised image.

C1S: Acronym for paper coated on one side only.

C2S: Acronym for papers coated on both sides.

Caliper: A way to measure paper thickness which is normally 
expressed in thousandths of an inch or points.

Camera-Ready Art: A file which is ready to be printed.

CMYK (Cyan, Magenta, Yellow, Black): The subtractive process 
colors used in color printing. 

Coated Paper: Paper having a surface coating which produces 
a smooth finish. 

Color Gamut: The range of colors that can be formed by all 
combinations of a given set of light sources and colorants.

Color Separations: The photographic or electronic means of 
separating color artwork into cyan, magenta, yellow and black 
components.

Computer-To-Plate: A technology that utilizes the transfer of 
digital data directly to a printing plate.

Contrast: The tonal gradation between the highlights, middle 
tones or shadows in an original or reproduction.

Cover Paper: Heavyweight paper that is commonly used for 
brochures, covers of books, and postcards.

Creep: In a saddle-stitched document, a stair-step condition 
caused by multiple overlaid signatures. 

Crop Marks: Lines printed at the edges of a printed sheet that 
detail where the paper is to be trimmed.

CTP (Computer To Plate): In platemaking, computer-to-plate 
systems or platesetters eliminate the need for having a separate 
film-to-plate exposure system.

Die: A metal plate used for making a impressed design on papers.

Digital Printing: Printing by plateless imaging systems that are 
imaged by digital data from prepress systems.

Duotone: A halftone image created by overprinting two 
different halftone screens of the same image with different 
colors and tonal ranges.

Emboss: A common finishing process which presses an image 
into a paper which creates a raised image.

Flood: The process of covering the entire sheet of paper with 
varnish or ink.

Foil Emboss: A process of stamping foil onto paper using a 
special die.

Foil Stamping: A common process of pressing foil onto paper 
using a heated die.

Foil: A thin metal film which is applied to paper in foil embossing 
and foil stamping.

Font: The complete assortment of upper-case and lower-case 
characters, punctuation and numerals of one typeface.

Four Color Process: A printing process which creates a color 
image by using the 4 colors of cyan, magenta, yellow and 
black (K).

Four Over Four (4/4): Four color printing on both sides of the 
piece of paper.

Four Over One (4/1): Four color printing on one side and one 
color printing on the other side of paper.

Four Over Zero (4/0): Four color printing on one side and no 
printing on the back side of a piece of paper.

Gloss: A shiny coating on paper. Gloss is the relative amount of 
incident light reflected from a surface. Gloss coatings allow very 
little ink absorption, thus providing excellent color definition 
and contrast.

Grain: In papermaking, the direction most fibers lie corresponds 
to the direction in which the paper is made on a paper machine.

Gutter: The inside space between pages, that is, the inside 
margin toward the back or binding edge of a book.

Halftone: A binary approximation of a continuous-tone image 
that enables the press to reproduce it using ink spots arranged 
in patterns.

Hickey: A defect in a printed sheet caused by lint, dried ink, dust 
or other contaminants.
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Image Area: The portion of a sheet which can be printed.

Imposition: Arrangement of pages so that they can print 
correctly on a press sheet and the pages are in proper order and 
orientation when the sheet is folded.

Inserts: Extra printed pages inserted into printed pieces.

Knockout: A portion of an image that is left blank or open.

Makeready: Also called setup, extra sheets of paper used to set-
up a job on the press.

Matte: Surface finish of a substrate that is not shiny.

Moire: In color process printing, the undesirable screen pattern 
caused by incorrect screen angles of overlapping halftones.

Offset Lithography: A printing process that uses the repellent 
properties of oil and water to reproduce an image on a flat 
surface that contains both the image and non-printing areas.

Page Count: Total number of pages in a printed document.

Pantone Matching System PMS: The standard color matching 
system used by most graphic designers and printers.

Perfect Binding: A binding method in which the binding edge 
of the book or magazine is ground down about 1/8 inch and 
coated with a fast-drying glue. Then, a flexible cover is attached, 
creating a squared-off backbone.

Perforation: The process of piercing small holes for tearing or 
folding.

Pixel: Abbreviation for a picture element. The smallest unit that 
can be sensed, manipulated, or output by a digital system or 
displayed on a computer screen. More pixels per inch means 
better resolution.

Plate: Reproduction of type and images on metal, plastic, rubber 
or other material to form a printing surface.

Point: Printer’s unit of measurement, used principally 
for designating type sizes. There are 12 points in a pica; 
approximately 72 points to an inch. 

Postscript: A vector-based page description language that is 
resolution and device independent.

Registration Marks: Marks outside the main image area on 
hard copy or electronic mechanicals that help keep plates and 
printing in register.

Registration: The fitting of two or more printing images in exact 
alignment with each other.

Resolution: The number of pixels in a printed image commonly 
expressed as pixels per inch (ppi) or dots per inch (dpi).

Reversed Type: Type knocked out or reversed in a colored field, 
such as white type in a black background.

RGB: Red, green, blue.  These colors are used in video displays.

RIP: In digital printing, a combination of computer software and 
hardware that controls the printing process by calculating the 
bitmaps of images and instructing the printing device to create 
the images.

Saddle Stitching: A binding method in which the signature is 
opened up and stapled at the center.

Score: A crease in a piece of paper which allows it to fold easier 
and without cracking.

Self Cover: A publication format where the cover stock is the 
same weight as the text stock, as opposed to attaching a 
separate cover of heavier paper.

Signature: The name given to a printed sheet after it has been 
folded.

Soft Proof: An image displayed on a color monitor that visually 
simulates the expected printed results from the same digital 
data.

Spot Varnish: Application of varnish to specific parts of paper.

Stock: The paper which will be used for printing the image on.

Substrate: A base upon which something is applied.

Text Stock: Paper used for the pages or reports, books, and other 
printing where the stiffness of card stock is not required.

Trapping: Image trapping is a technique in which abuting 
colors are slightly overlapped to minimize the effects of 
misregistration of the printing plates.

Trim Marks: Marks placed on the copy to indicate the edge of 
the page.

Typesetting: A process of arranging artwork or test in 
preparation for printing.

UCR: In process multicolor printing, color separation films are 
reduced in color in neutral areas where all three colors overprint 
and the black film is increased an equivalent amount in these 
areas.

Uncoated Paper: Paper that has not had a final coating applied 
for smoothness or sheen.

UV Coating: A clear plastic coating which is applied to paper in 
a liquid form and cured by ultraviolet light.

Varnish: A clear liquid coating applied to paper printed products 
during the printing process.

Watermark: A design created in paper during the production of 
the paper which is visible in the paper.

Wire-O: A common binding method which uses wire with 
double loops.


